Operation Manual

Software

FanTestic Integrity
(Venting Calculator)
Table of Contents

1 Installation instructions 4
1.1 Minimum system requirements ................................................................................................... 4
1.2 Download FanTestic Integrity ................................................................................................... 4
1.3 Start FanTestic Integrity ........................................................................................................... 8
1.4 Enter a license key .................................................................................................................... 8
1.5 Select a testing standard to use .............................................................................................. 11
1.6 Change language for user interface (and generated reports) .................................................. 13

2 Calculate Pressure Relief Vent leakage area needed for system design 14
2.1 Open Venting Calculator ........................................................................................................ 14
2.2 Choose units for values in the calculator ............................................................................. 15
2.3 Choose venting equation to use for peak pressure ............................................................... 16
2.3.1 Warning about venting equations ....................................................................................... 16
2.4 Choose enclosure leakage standard for calculating max hold time .................................... 17
2.5 Choose agent discharge model used in calculations ............................................................ 17
2.1 Choose the extinguishing agent ........................................................................................... 18
2.2 Enter extinguishing agent details ........................................................................................ 22
2.2.1 Case of Inert gas extinguishing agents with FSSA: ............................................................. 22
2.2.2 Case of Halocarbon gas extinguishing agents with FSSA and FIA: ................................. 22
2.2.3 Case of Inert gas extinguishing agents with VdS and FIA: ................................................ 23
2.2.4 Case of Halocarbon gas extinguishing agents with VdS: .................................................. 23
2.2.5 Case of gaseous CO2 extinguishing agent with NFPA12: ............................................... 24
2.3 Enter enclosure conditions during hold time .......................................................................... 24
2.3.1 Case of Inert gas extinguishing agents with FSSA: ............................................................. 24
2.3.2 Case of Halocarbon gas extinguishing agents with FSSA and FIA: ................................. 24
2.3.3 Case of Inert gas extinguishing agents with VdS and FIA: ................................................ 24
2.3.4 Case of Halocarbon gas extinguishing agents with VdS: .................................................. 25
2.3.5 Case of gaseous CO2 extinguishing agent with NFPA12: ............................................... 25
2.4 Enter enclosure details ........................................................................................................... 25
2.5 Enter performance criteria ...................................................................................................... 26
2.5.1 Case of “Descending interface” as discharge model .......................................................... 26
2.5.2 Case of “Continuous mixing” as discharge model ........................................................... 26

3 Calculate the maximum enclosure leakage to maintain the specified hold time 26
4 Calculate Pressure Relief Vent area needed 27

4.1 Case of Inert gas extinguishing agents ................................................................. 27
4.2 Case of Halocarbon gas extinguishing agents with FSSA and FIA: .......................... 27
4.3 Case of Halocarbon gas extinguishing agents with VdS: ....................................... 27

5 Save results to a file (.docx) 28

6 Troubleshooting 28

6.1 Report an Issue ...................................................................................................... 28

7 License 29
1 Installation instructions

While FanTestic Integrity software may identify clean agent peak pressure and hold time risks, use of this software does not in any way guarantee the elimination of those risks.

1.1 Minimum system requirements

- Microsoft Windows O/S: XP (SP2 or greater) or newer (Vista/7/8) – current with all updates
- Processor: 1 GHz
- RAM: 512 MB
- Disk space: 600MB (32-bit) or 1.5 GB (64-bit)
- Internet connection with Microsoft Internet Explorer (for automatic software updates)
- .NET 4.0 framework (will update automatically with the FanTestic Integrity installation)

1.2 Download FanTestic Integrity

- Go to: http://www.retrotec.com/support/software-downloads

- Click the “Download” button next to FanTestic Integrity
• Click the “Install” button on the window that opens.
• When prompted with “Do you want to run or save setup.exe?” click on the “Run” button.
If not prompted, go to the Downloads menu option on your web browser and double-click on the file you have just downloaded (which is called “setup.exe”).

The “Application Install – Security Warning” window will open:
- click on the “Install” button.

- If the User Account Control (UAC) asks for permission, you must give administrator permission for the software to install the USB driver.
- After installation, FanTestic Integrity will open on your desktop.
The first time you run FanTestic Integrity, you need to make some choices about how you will use FanTestic Integrity – access from the “Settings” menu as described in the next sections.

### 1.3 Start FanTestic Integrity

There are two ways to start the program:
- Click on Windows “Start Menu” → “All Programs” → “Retrotec” → “FanTestic Integrity”,
- or click the FanTestic Integrity icon on your desktop.

FanTestic Integrity (FTI) will run in demo mode with full functionality for 60 days after you first install. Once the demo version expires, you will not be able to generate the MS Word reports or export your test data to MS Excel. You will still be able to enter test data and see the results on-screen.

Obtain a license and instructions for activating the software with the license before your demo expires by contacting sales@retrotec.com. The license will be valid for the period of time specified for the license, and once the license expires, you will not be able to generate the MS Word reports or export your test data to MS Excel. You will still be able to enter test data and see the results on-screen.

If your demo or license has expired you will see a dialog window similar to the following when you start FanTestic Integrity:

![Dialog window for expired license]

### 1.4 Enter a license key

- Open FanTestic Integrity, if not already open.
- Once in the program click “Settings”
- Then click “Enter license details”.

![Settings window with Enter license details option]
- Click on the “Install License Key” button
• then copy and paste the license key from the email you received into the text box that appears, being sure to include the “===START_KEY===” and “===END_KEY===” portion of the key. If selecting from an email, be sure that the email has not inserted any odd items into the string, such as an “emailto” link. The email containing the key that is sent out from Retrotec will be a “Text only” email, not HTML based, in order to try to minimize license corruption.

• Click on the “Install License” button below the text box.
• Next, select a standard, and then fill in the user name and email address and then click “OK”. “Software user’s company” will be filled in automatically from the license that was entered.

1.5 **Select a testing standard to use**

• Open FanTestic Integrity, if not already open.

• Click on Settings:

  then click on “Change Standard used for new tests”
Next, select a standard from the list, and then click “OK”. For NFPA, you can choose to see the values in metric units or imperial/mixed units (imperial units for all items except pressure is in Pascals). Access is also provided to doing calculations based on the old version of the standard, only for comparison with results from tests performed with the old and discontinued CA2001 software.

Changes can be made any time, but a new test file must be created for the new settings to be used.

If a test file is already open when changes are made, you will be warned before the software creates the new file. If you do not let the software create a new file at that point, the old file will remain open with the old settings until you click “File” → “New”, or use the “New test” link on the Test History menu, to create a new test using the new standard you chose.
1.6 Change language for user interface (and generated reports)
2 Calculate Pressure Relief Vent leakage area needed for system design

2.1 Open Venting Calculator

Click on the “start venting calculator” button on the “Enclosure leakage design” expander tab.

Alternatively you can click on the Tools menu and use the “Calculate Pressure Relief Vent needed for system design” menu option:
The venting calculator will open:

![Venting Calculator using metric units](image)

**Figure 1: Venting Calculator using metric units**

### 2.2 Choose units for values in the calculator

#### Venting Calculator

**units**  metric  mixed  imperial

You may wish to change to mixed units (imperial for all units except pressure which is in Pascals) or imperial units (where pressure is in PSF).
2.3 Choose venting equation to use for peak pressure

2.3.1 Warning about venting equations

If you choose NFPA12, FIA or VdS, please heed the following warnings:
If you choose to use equations relying on peak mass flow rate to calculate peak pressure and minimum leakage required to relieve the peak pressure, entering smaller peak flow rates to override default values may result in under-estimating minimum venting area required. Such an under-estimation would lead to over-pressurization if a smaller than necessary vent is installed.

### 2.4 Choose enclosure leakage standard for calculating max hold time

<table>
<thead>
<tr>
<th>units</th>
<th>metric</th>
<th>mixed</th>
<th>imperial</th>
</tr>
</thead>
<tbody>
<tr>
<td>discharge type</td>
<td>Descending Interface</td>
<td>Descending Interface</td>
<td>Continuous Mixing</td>
</tr>
</tbody>
</table>

### 2.5 Choose agent discharge model used in calculations

Select which type of fire suppression system discharge model will be assumed for calculation of the maximum leakage for the specified hold time.

There are two options, defined according to how the extinguishing agent behaves after a discharge in the enclosure:

“Descending Interface”—Agent is discharged at near-ceiling level into the enclosure. An ‘interface’ with a constant concentration (known as the Initial Concentration) descends from the discharge level as gas leaves the enclosure through leaks. The time it takes for this ‘interface’ to reach the Minimum protected height is defined as the “hold time”.
“Continuous Mixing” – Agent is discharged at near-ceiling level into the enclosure. Fans circulate gas throughout the room, resulting in a uniform agent concentration. This concentration begins at Initial Concentration and reduces until it eventually reaches the specified Minimum Concentration. The time it takes for the Initial Concentration to reach the Minimum Concentration is defined as the “hold time”.

2.1 Choose the extinguishing agent

The list of extinguishing agents will depend on the choices in the venting equation and enclosure leakage standard drop downs.

- “Agent”
  Select which agent is used for the enclosure’s fire suppression system.

![Agent Info](image)

**Figure 3:** Available extinguishing agents for NFPA2001 with FSSA
Figure 4: Available extinguishing agents for ISO14520/EN15004 with FSSA
Figure 5: Available extinguishing agents for ISO14520/EN15004 with VdS
Figure 6: Available extinguishing agents for NFPA2001 with VdS

Figure 7: Only CO2 is available as an agent if NFPA12 equation is chosen
2.2 Enter extinguishing agent details

**units**  •  metric  •  mixed  •  imperial

**venting equation**  FSSA for NFPA2001

**enclosure leakage Standard**  NFPA 2001 (2012)

**discharge type**  Descending interface

**gent Info:**

<table>
<thead>
<tr>
<th>Agent</th>
<th>Argon [IG-01]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial concentration</td>
<td>40%</td>
</tr>
<tr>
<td>Discharge time</td>
<td>60 s</td>
</tr>
</tbody>
</table>

- **“Initial concentration” [% volume]**
  The initial concentration, as a percent of volume, of agent in the enclosure immediately after a complete discharge (i.e. the concentration of agent at the beginning of the hold time). Defaulted to 40% for inert agents and 7% for halocarbon agents. It is used along with the entered enclosure volume to calculate the agent mass, behind the scenes.

- **“Discharge time” [s]**
  The agent’s discharge time in seconds. This value should be obtained from the fire suppression system design specifications. FanTestic Integrity defaults this value to typical discharge times: 60 s for inert agents and 10 s for halocarbon agents.

2.2.1 Case of Inert gas extinguishing agents with FSSA:
Uses a leak to volume ratio for the calculation of pressure relief vent area which depends on the chosen agent, so no peak mass flow needs to be entered. Thus the peak mass flow rate data entry box is not available in the user interface.

2.2.2 Case of Halocarbon gas extinguishing agents with FSSA and FIA:
Uses a leak to volume ratio for the calculation of pressure relief vent area which depends on the chosen agent, so no peak mass flow needs to be entered. Thus the peak mass flow rate data entry box is not available in the user interface.
2.2.3 Case of Inert gas extinguishing agents with VdS and FIA:
Uses a peak mass flow rate for the calculation of pressure relief vent area, which is defaulted to a value consistent with experiments for each agent.

2.2.4 Case of Halocarbon gas extinguishing agents with VdS:
Uses a peak mass flow rate for the calculation of pressure relief vent area, which is defaulted to a value consistent with experiments for each agent.
2.2.5 Case of gaseous CO2 extinguishing agent with NFPA12:
Uses a peak mass flow rate for the calculation of pressure relief vent area, which is defaulted to a value consistent with experiments.

2.3 Enter enclosure conditions during hold time
Enter the minimum anticipated temperature that the enclosure could experience during a discharge.

Enter the minimum and maximum relative humidity in %, in cases where it is necessary as outlined in the next sections:

2.3.1 Case of Inert gas extinguishing agents with FSSA:
Adjustments are made using temperature in the calculation of pressure relief vent area, so only temperature is available to be entered.

2.3.2 Case of Halocarbon gas extinguishing agents with FSSA and FIA:
Adjustments are made using temperature and relative humidity in the calculation of pressure relief vent area, so all are available to be entered.

2.3.3 Case of Inert gas extinguishing agents with VdS and FIA:
Adjustments are made using temperature in the calculation of pressure relief vent area, so only temperature is available to be entered.
2.3.4 Case of Halocarbon gas extinguishing agents with VdS:
Adjustments in VdS equations are made using temperature in the calculation of pressure relief vent area, so only temperature is available to be entered.

2.3.5 Case of gaseous CO₂ extinguishing agent with NFPA12:
Adjustments are made using temperature in the calculation of pressure relief vent area, so only temperature is available to be entered.

2.4 Enter enclosure details

- “Maximum flooded volume”
  Calculate and enter the enclosure volume that is to be flooded with agent.
- “Maximum flooded height”
  Enter the maximum flooded height, which is the height of the installed nozzles for the agent discharge.
- “Lower leakage fraction”
  Enter a value between 0.15 and 0.5 which represents how much of the leakage occurs in the lower part of the room versus the total enclosure leakage. The default of 0.5 is the most conservative value.
2.5 Enter performance criteria

2.5.1 Case of “Descending interface” as discharge model

<table>
<thead>
<tr>
<th>performance criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enclosure pressure limit: 500 Pa</td>
</tr>
<tr>
<td>Protected height: 9.2 ft</td>
</tr>
<tr>
<td>Hold time: 10 min</td>
</tr>
</tbody>
</table>

- “Enclosure pressure limit”
  Enter the pressure limit for the enclosure. Any peak pressure higher than this value is expected to result in structural damage.

- “Protected height”
  Enter the protected height (the highest level of combustibles). This height is usually measured to the top of the equipment you are trying to protect.

- “Specified hold time”
  The required Hold time for a passing test, also known as the “hold time”.

2.5.2 Case of “Continuous mixing” as discharge model

<table>
<thead>
<tr>
<th>performance criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enclosure pressure limit: 500 Pa</td>
</tr>
<tr>
<td>Minimum concentration: 35 %</td>
</tr>
<tr>
<td>Hold time: 10 min</td>
</tr>
</tbody>
</table>

- “Enclosure pressure limit”
  Enter the pressure limit for the enclosure. Any peak pressure higher than this value is expected to result in structural damage.

- “Minimum concentration”
  The final concentration in the enclosure at the end of the hold time

- “Specified hold time”
  The required Hold time for a passing test, also known as the “hold time”.

3 Calculate the maximum enclosure leakage to maintain the specified hold time

Click the “Calculate” button once all the data is entered in order to view the results; gray boxes show the calculated results and are not editable.
Choose the % of the enclosure leakage available that will be used as part of the leakage for peak pressure relief.

4 Calculate Pressure Relief Vent area needed

Enter your data into all the yellow boxes – the yellow boxes indicate required entry items without default values. They will turn green after entry.

Click the “Calculate” button once all the data is entered in order to view the results; gray boxes show the calculated results and are not editable.

Pressure relief vent area is the size of the vent that will be required, already taking into account that the specified percent of enclosure leakage will also be available for peak pressure relief. This additional leakage needs to be put in place so that Peak Pressure can be lowered to the point where the structural integrity of the enclosure is not compromised during agent hold time.

4.1 Case of Inert gas extinguishing agents

Only positive pressure relief will be needed, so that is all that is calculated.

4.2 Case of Halocarbon gas extinguishing agents with FSSA and FIA:

As long as data is available defining the Leak to Volume ratio for the agent, both positive and negative pressure relief area will be calculated. All the agents in the list have data.

4.3 Case of Halocarbon gas extinguishing agents with VdS:

VdS equations assume only positive peak pressures will occur, so no negative PRV area can be calculated, even though experiments show that negative peak pressures usually form.
5  Save results to a file (.docx)

Test files are normally saved on your local C: drive under [MyDocuments]\Retrotec\Tests.

If you enter a new file name, the Venting calculator will create a docx file with fields for each of the items in the user interface, and then put the values from the calculator into the file.

If you chose an existing docx file, which has already been created by the Venting calculator, the fields will be updated with the values from the calculator rather than creating a new file.

You will only be able to generate the .docx report file containing the results if you have a valid, non-expired license for FanTestic Integrity. If you do not have such a license, you will be limited to seeing results on the screen.

6  Troubleshooting

6.1  Report an Issue

If you experience a problem that you cannot fix by troubleshooting, make sure you have the latest version of FanTestic software, see section 1.2. If you are still having problems even using the updated software:

- For Technical Support, contact support@retrotec.com
- E-mail bugs, comments or suggestions to: bugs@retrotec.com

In your email, describe the problem and when it occurs, and attach the following:
- The standard are you using (click “Tools” → “Settings” → “Change Standard” to check)
- Log file from [My Documents]\Retrotec\Logs
- Test file you are using, file extension .fxml
- Settings.xml file [My Documents]\Retrotec\AppData
• A screenshot of the software running or having the error

Each test has an associated log file that is saved on your C: drive, in the Retrotec folder. These logs will help Retrotec to determine where the problem occurred. You can access the log files in your local drive, in [My Documents]\Retrotec\Logs. A new log file is created for each day, named Log_yyyy-MM-dd.txt. If you leave FanTestic Integrity running over the course of multiple days, the log file will have the date of the day when FanTestic Integrity was initially started.

The .fxml test files can be found in your local drive, in [My Documents]\Retrotec\Tests folder, and are saved by default with the date and time in the name. Send the .fxml file having the date you began the test.

The Settings.xml file is found in your [My Documents]\Retrotec\AppData folder, and contains information troubleshooting personnel can use to diagnose the problem.

Screenshots are a way to show our Technical Support staff what your error looks like on your screen. This will help us to determine the best approach to fix the problem. To capture an image of the screen you are currently looking at, push the “Print Scrn” button on your keyboard. In order to attach this image as a file for us to view, you must paste it into a document. To do this, open a new Microsoft Word or Paint document, right click on your mouse and select “Paste” (or “Edit” → “Paste”). The captured image of your screen should appear in the document. You can now save this document and include it as an attachment when you email the files to Retrotec.

7 License
E-mail license pricing inquiries to sales@retrotec.com. Once you receive your license key in the mail, ensure that you have the latest version of FanTestic Integrity installed on your computer and then refer
to section 1.4 for detailed instructions on entering the license into the latest version of FanTestic Integrity.

You will be able to generate the .docx report file containing the results when you have a valid, non-expired license.